
We just can’t believe how fast this year has 
gone by. With Christmas fast approaching, 

we would like to take this opportunity to wish all 
our VectorWorks users the very best for the season 
and trust you all have a restful break. As a small 
bonus, we have included more than usual in the 
Tips and Tricks section of this issue. Remember if 
you have any tips of your own, we are more than 
happy to include them in an upcoming issue.

VectorWorks Used for Casino Royale
VectorWorks Designer was used in designing the sets for the 
new James Bond film CASINO ROYALE, which recently 
opened in theatres worldwide.
Art director Steven Lawrence used VectorWorks Designer to 
produce 2D drawings and site plans for the movie, to assist 
the production designer and director in mapping out how 
action would take place within an area. Lawrence also used 
VectorWorks Designer to create 3D models of sets to help the 
team get a feel for a set before they arrived on location.
“EON Productions wanted to kick off a whole new era for the 
Bond films, and we wanted to do that within the art depart-
ment as well, with a hot, new look,” says Lawrence. “Most art 
departments in the UK still draw with pencil and T-square 
and are skeptical of such a radical change. But when they start 
to use a few of the tools within VectorWorks Designer and see 
how much more they can do and how much faster they can 
work, they’re blown away.”
Click here to download the PDF to read more.

Sydney Training Course – February
Information about the next Sydney training course is now on 
our web site. The dates are Monday 19th to Thursday 22nd 
February 2007, and participants can enrol in one or more 
days. This course is considered a formal CPE contributor for 
architects and each hour of participation will be able to be 
recorded as one formal hour of CPE against the annual Archi-
tects Registration Board requirement. Click here to go to our 
web site for more information.

Prior Version Upgrade Discounts
Nemetschek North America have advised us that prices for 
upgrades to VectorWorks 12.5 from older versions (Vector-
Works 10 or older) will be increasing on 1st February 2007. 
Consequently we have arranged some special prices valid to 
January 31st 2007, to entice these older version users to get 
with the latest and greatest version. If you did not receive 
notification of this in the mail or would like more informa-
tion or a quote, please contact us. Not only can you save up to 
15%, but you will also beat the price rise.

Training Materials in Stock
We now have more stock of Jonathan Pickup’s Essential 
VectorWorks manual for VectorWorks 12. For more informa-
tion on this or other training materials, click here to go to our 
web site.

OzCAD Closing Times for the Holidays
The offices of OzCAD will be closed from 12:00pm on 
Friday 22nd December and will reopen on Monday 8th 
January 2007. During this time, we will still be checking 
messages and email, so if you have an urgent enquiry, please 
leave a message or send an email.

Tips and Tricks
What is the best method for importing a DWG file from 
AutoCAD into VectorWorks 12.5?
This is a common question that will not always yield the same 
answer. Consider this anecdote from a VectorWorks user:

To be honest, I have more problems translating AutoCAD files 
from consultants/architects into something usable in AutoCAD 
than I do with VectorWorks. In my job, I’m basically the ‘portal’ 
through which all our project files come through, and every 
project has one (or two) architectural firms, a surveyor, interior 
architect, structural, mechanical, electrical and fire protection 
engineers, landscape architect, etc. 

Every one of them sets up their AutoCAD drawing differently, 
plots it differently, and uses different .ctb files (and always for-
gets to include them). Some work totally in Modelspace (and plot 
from there) and some work in Model/Paperspace. Some scatter 
floor plans and drawing parts all over the (model) place, some 
stack them neatly on top of each other (like they should) and use 
viewport display settings. Some use multiple Layout Tabs, some 
don’t. Most draw to scale, some don’t. Some plot using Layout, 
some using Extents, others using Display, etc.

So not all DWG files are created equal! With this in mind here 
are some tips for making file translation easier. Before we 
begin, here what you should try to obtain before attempting to 
import the file:
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into your drawing and have to carry this baggage for the 
remainder of the project. It is also not possible to scale 
an imported drawing if there are other objects already in 
existence. Instead, open a blank file with the correct units 
(perhaps a predefined template file), then do the import. 
2. Always use the Import Single DXF/DWG File command.

Using this command to import the file will ensure that the 
Import DXF DWG Import Options dialogue appears and 
act as a reminder that there are things to check and set.
3. Consider converting the file to 2D on import.

If you only require 2D information from the file, consider 
choosing 2D from the Convert Objects To drop down menu. 
This will make the drawing more convenient to work with 
and see things like associative hatches correctly applied. It 
will also generally do a better job than you can do with the 
VectorWorks convert commands.
4. Consider the drawing scale.

DWG files do not contain drawing scale information. What 
VectorWorks does to try and guess the correct scale, is to 
look at your current page size, then fit the whole DWG file 
onto that page. Given that DWG files typically have stuff 
scattered about and that you have not matched the page size 
in VectorWorks to the DWG file, this is a pretty inaccurate 
way of ascertaining the drawing scale. Consequently, it is 
much better for you to click the Scale... button and set the 
Model Space scale to what you know the drawing to be.
5. Always clean up the imported file.

Once the DWG file is successfully imported yet isolated 
from your working file, you have the opportunity to clean it 
up. This might involve: 
• Deleting or merging classes, which is easy with multiple 
selection in the Organization dialogue. Select multiple 
classes, click the Delete button, then choose the class for 
the objects to go into. Alternatively, you can also delete the 
objects. 
• Removing unneeded Sheet Layers or Viewports, consult-
ant’s title blocks, drawing notes, unneeded geometry, etc. 
• Converting whole floor plans that are symbols to groups 
to make their geometry easier to access (choose Don’t con-
vert sub-objects to groups in the Options dialogue). 
• Purging unused objects using the Purge Unused Objects 
command in the Tools menu. This can dramatically reduce 
file size and reduce clutter in resource lists such as symbols 
and hatches. 
• If the origin in the file is unimportant, Select All then 
reposition the objects to a convenient location on the page.

Once the file is cleaned up and ready for use, there are two 
ways you can transfer this information to your working file.

1. Using Copy and paste.

This is the simplest way to transfer data. Start by prepar-
ing the destination layer in your working file, giving it an 
appropriate name and the same layer scale as the imported 
drawing. In the cleaned up file, Select All then Copy. Switch 
to your working file then choose Paste in Place, or right 
click and choose Paste to centre the copied objects in a 
specific location.
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1. A hard copy or PDF of the original file.

Knowing how a drawing is supposed to look is a sure fire 
way of discovering if there have been any errors in the 
translation. It can also reveal things like page size, scale 
and units.
2. The units that were used (if any). 

Drawings are typically done in millimetres or metres, 
however it is possible to draw in AutoCAD without actually 
specifying the units that were used. In this case Vector-
Works 12.5 will try and guess the units if the import option 
is set to Determine Automatically. Take a look at the guess 
VectorWorks has made and if it is something like:

	 1 DXF Unit = 25.4mm

(and the DWG file didn’t come from the USA), chances are 
the guess is wrong. In this case, choose Metres or Millime-
tres (based on the information you have about the file) from 
the menu that says Determine Automatically.
3. The AutoCAD version that was used to create the file.

This will enable you to ascertain whether the version 
of VectorWorks that you have is compatible with the 
AutoCAD version used to create the file. Currently Vector-
Works 12.5 can import up to and including AutoCAD 
2006 files. If you can’t obtain this information, there is 
another way to determine the AutoCAD version. Open the 
AutoCAD file in any text editor and the first six characters 
will reveal the version. Use the following table to decipher 
the number:
AC1002 = release 2.5	 AC1012 = release 13
AC1003 = release 2.6	 AC1014 = release 14
AC1004 = release 9	 AC1015 = release 2000/2002
AC1006 = release 10	 AC1018 = release 2004/2005/2006
AC1009 = release 11/12	 AC1021 = release 2007
4. The .ctb file that defines the line weights/colours.

If you can get the .ctb file then the translation will be more 
accurate as the line weights will be correctly translated. 
Even though AutoCAD can apply true line weights to 
objects, there are many users who still use the old method 
of line colours, so the .ctb file is still required.
5. All files that are referenced by the main file. Alternatively, 
you can ask that Xrefs be bound to the main file.

It is very common for AutoCAD users to reference or link 
one or more files into their main drawing. These are called 
Xrefs and if you have been sent a DWG file that utilises 
them, you will also need to get these files so that Vector-
Works can import the data from them. If you prefer to get 
only a single file from your consultant or client, then you 
can request that they bind the Xrefs in with the main DWG 
file.

Assuming that you have all the required information, DWG 
files etc., let’s look at the rules for importing.

1. Always import into a blank VectorWorks drawing.

Never ever import a DWG file into a working file. Not 
only is there a risk of bringing in a corrupt object, but you 
will bring lots of unnecessary classes, symbols and objects 

1. Moving a Chain Dimension – original position
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2. Using the Workgroup Reference Command.

This command allows you to transfer one or more layers 
from one file (often called the Source file) to another file 
(often called the Destination file), then update the informa-
tion in the Destination file if or when changes are made to 
the Source file. You can also break or remove a reference, 
but choose to keep the referenced information, thereby 
transferring it from one file to another. Workgroup Refer-
encing (WGR) is particularly useful when a DWG file you 
have imported is likely to be updated during a project. In 
this case you can reimport and clean up a new version of 
the file into your Source file, then update the WGR to have 
the newer information displayed in your Destination file.

So what happens when you take all these precautions and the 
imported information is still the wrong size? As mentioned 
previously, this can be the result of an incorrect or absent set-
ting in AutoCAD, so the first thing to do is to establish what 
the error is. 
To do this you need to measure something in the drawing of a 
known size. If there is a scale bar, great. If not, then try to find 
a dimensioned object. I find drawing a line is the easiest way 
to measure something. Once done, you can read or copy the 
length from the Obj Info palette (click the Polar Coordinates 
button to get the readout in Length/Angle format).
Now, let’s say you know something should measure 3565mm, 
but it scales at 3.565mm. From this you can immediately see 
that the drawing is 1000x too small, so there was a mismatch of 
units in the import dialogue. It was incorrectly set to:
	 1 DXF Unit = 1mm
when it should have been set to:
	 1 DXF Unit = 1000mm
In other words, the drawing was done in metres but imported as 
millimetres. The simplest solution is to just do the import again 
into a fresh file. If you get a factor like 24.5, 39.37, 0.03937, 
then it is a metric/Imperial issue and again just a mismatch in 
the units setting in the import dialogue. 
If the known measurement scales at something completely 
arbitrary however, then a different strategy is needed. Say the 
known measurement is 3565mm, but scales at 287.3mm (make 
your measurement more accurate by temporarily increasing the 
number of decimal points in the Units dialogue). The drawing 
needs to be scaled by the following factor:
	 3565 / 287.3
(always put the known size over the measured size). You can 
do this by deselecting everything then choosing Scale Objects 
from the Modify menu and entering exactly the same text:
	 3565 / 287.3
then clicking OK. VectorWorks will do the maths for you. If 
you have one or more objects selected, then you will have to 
check the Entire Drawing box yourself. If you do this, make 
sure you remember to uncheck it if you come back later to 
scale a single object.
Now repeat the measurement of the known object. If it scales 
correctly the drawing is fixed. If it is still slightly off you 
can repeat the process, but remember that drawings are not 
always drawn with accuracy, so measure a few different lines 

or objects. I have seen survey drawings where line lengths do 
not correspond to written dimensions so the moral is to never 
assume anything. 
Of course the required accuracy of an imported drawing 
depends on its use. If you are simply overlaying some plants for 
a landscape drawing, then accuracy to 0.1mm is probably not 
that critical. If you are doing 1:1 setout drawings for complex 
machinery, then accuracy is more paramount.
The last piece of advice I have is to record what you did for 
each consultant or client that you received DWG files from. 
This way you have a much better chance of repeating a success-
ful workflow when receiving drawings from them in the future.

How do I set a custom view in a viewport?
Setting a custom view in a Viewport is best done by first setting 
the view you want in one of the Design Layers. Once done, you 
can then choose Create Viewport from the View menu and a 
Viewport will be created with the same view on the nominated 
Sheet Layer. Other Design Layers can then be added to the 
Viewport via the Layers button on the Obj. Info palette.
How can I change the ID of a plant I have placed on a 
drawing in VectorWorks 12.5?
When you place a plant on a drawing, a symbol is created for 
that particular plant in the Resource Browser and will be vis-
ible in the Symbols/Plug-in section. The name of the symbol 
is the same as the plant ID. If you right click (Ctrl + click 
on a single button mouse) and choose Rename, you can then 
change the name of the symbol. This will flow through to all 
instances of the plant in the drawing.
Can I do calculations while I am entering sizes into 
VectorWorks?
Certainly. Any place where you can enter a dimension in 
VectorWorks (Data Bar, Object Info palette, dialogues, etc.), 
you can use maths operators. The basic operators are:
	 +  for addition
	 -  for subtraction
	 *  for multiplication
	 /  for division
Here are some examples. If you have been out on site and 
taken a bunch of dimensions, you can enter these as:
	 235 + 940 + 605 + 130
and when you press Enter, VectorWorks will add up then 
enter the total. Have a rectangle and would like to halve its 
width? Click at the end of its X dimension in the Obj Info 
palette, type /2 (forward slash 2) then press Enter.
Want to do a more complex calulation? No problem because 
VectorWorks will follow the high school rules of maths. 
Remember BODMAS (brackets of division multiplication 
addition subtraction)? If you enter something like this:
	 4*6+2/5
VectorWorks will do the division first, then the multiplication, 
then the addition. Of course you can use brackets if desired, 
but they are only needed if you want to override standard 
operations.


